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	The Computer—An Overview	The Computer—An Overview

One LearnTouch

A.	 1. a		  2. b			   3. a			   4. c			   5. c
B.	 1.	 impact		 2. webcam	 3. joystick		 4. pixels		  5. Gigabyte		  6. USB
C.	 1.	Memory Card			   2. Hard Disk	 3. ROM		  4. RAM

ItLet's Do

A.	 1.	A touch screen is a screen that is sensitive to touch and helps us to interact with computers 
by touching the areas on the screen. 

	 2.	A Computer takes the data as input, processes and then gives result as an output. 
	 3.	Hard disk is a secondary storage device that is used to store data permanently. 
B.	 1.	The three main components of CPU are:
	 	   ALU (Arithmetic Logic Unit):  Performs mathematical and logical operations.
	 	   CU (Control Unit): Directs all the operations of a processor.
	 	   Memory Unit: Stores data and instructions.
	 2.	 Impact printers create an image on a paper by striking the paper with a metal.
	 	 Example: Dot matrix printer.
	 	 Non-impact printer create an image on a paper by spraying ink on the paper.
	 	 Example: Inkjet printer.
	 3.	There are two types of RAM: 
	 	 (i)	 Static RAM
	 	 (ii)	 Dynamic RAM 
	 4.	Pen drive: It acts as a portable hard drive and is easy to use as it is small and can be carried 

in a pocket and plugged into any computer with a USB drive. 
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Crack CodeThe

	 1.	 Input		  2. Output			  3. Input		  4. Input		  5. Output			  6. Input

Do yourself.

	Windows 7	Windows 7

One LearnTouch

A.	 1.	a		  2. b			   3. a			   4. c
B.	 1.	downloads				    2. folder		  3. subfolder		  4. Windows Explorer
C.	 1.	T		  2. T			   3. T		
	 4.	(This question was incorrect in the textbook, please correct it in your textbook)
	 	 Q. Jump list does not takes us to the frequently used documents.
	 	 A. True

ItLet's Do

A.	 1.	Common folders provided by Windows 7 are: 
	 	 • Documents    • Pictures    • Music    • Videos    • Downloads
	 2.	Organised files and folders help us to find the right files to use when we run a program. 
	 3.	When we copy and move a file, it is removed from its original location and appear a new 

location. 
B.	 1.	Folder is a collection of various files and sub folders whereas a file is a collection of related 

information.
	 2.	Steps to delete a file or folder are: 
	 	 Step 1  Open the file or folder you want to delete. 
	 	 Step 2  Click on File or folder 
	 	 Step 3  Click on Organize 
	 	 Step 4  Click on Delete 
	 	 Step 5  Click on Yes 
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Crack CodeThe
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Do yourself.

Periodic Assessment-1Periodic Assessment-1
(Based on chapters 1 & 2)(Based on chapters 1 & 2)

A.	
Address bar SearchForward

Back

Toolbar

Status bar

Navigation
pane

File list
Pane

B.	 1.	(c)		  2. (a)				   3. (d)		  4. (b)
C.	 1.	 Image file	 2. Document file	 3. Spreadsheet file
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	Advanced Features of MS Word 	Advanced Features of MS Word 

One LearnTouch

A.	 1. c		  2. c		  3. b		  4. a
B.	 1.	Resizing	 2. Merging		  3. Layout			  4. Design	
	 5.	(This question was incorrect in the textbook, please correct it in your textbook)
		  Q. _____________is the white space all around the printed area of the paper.
		  A. Page margin
C.	 1.	F		  2. T			   3. T			   4. F				    5. F

ItLet's Do

A.	 1.	 It is the intersection of rows and columns. 
	 2.	Header is the text that appears at the top of each page of the document. 
		  Footer is the text like page number that appears at the bottom of each page of the document. 
	 3.	Page margin is the white space all around the printed area of the paper. 
B.	 1.	To add a row, follow these steps:
	 	 Step 1  Select the row where you want to add another row.
	 	 Step 2  Click on the layout tab.
	 	 Step 3  Click on Insert Above or Insert Below command. A row will be added.
	 2.	To insert a table, follow these steps:
	 	 Step 1  Open the MS Word and click on the Insert tab.
	 	 Step 2  Click on the Table command in the Tables group.
	 	 Step 3 � �Move the mouse over the squares to select columns and rows for the table. When 

you move the mouse over the squares, a sample table is visible in the document.
	 3.	The Mail Merge feature in MS Word is used to create personalised letters to be sent to many 

persons. 

44..	Graphics in MS Word 2010	Graphics in MS Word 2010

One LearnTouch

A.	 1.	b	
	 2. (This question was incorrect in the book. Please correct it in your textbook)
	 Q. Which of these commands is present in the Text group?
	 a. Shapes			  b. Picture			  c. WordArt
		  Answer: c. WordArt
	 3. c			   4. c
B.	 1.	Shapes		 2. Insert		  3. Add text	 4. ClipArt		 5. 3D
C.	 1.	F		  2. F			   3. T			   4. T

ItLet's Do

A.	 1.	(This question was incorrect in the textbook, please correct it in your textbook)
		  Q. What do you mean by Bevel?
		  A. Bevel adds thickness and rounded edges to shapes.
	 2.	By clicking on the Fill command in the shape style group in Format tab, we can change the 

colour of a shape in MS Word 2010.
B.	 1.	WordArt allows us to create text effects that can not be inserted through text formatting. 

Whereas, ClipArt helps us to insert pre-designed pictures to make our document look 
professional. 

	 2.	To insert a picture in a document, follow these steps:
	 	 Step 1  Place the cursor where you want to insert pictures.
	 	 Step 2  Select the Insert tab.
		  Step 3  In the Illustrations group, click on the Picture command.
		  Step 4  Select the desired picture and then click on Insert button.

Crack CodeThe

WordArt

Do yourself.
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	Advanced Features of MS Word 	Advanced Features of MS Word 

One LearnTouch

A.	 1. c		  2. c		  3. b		  4. a
B.	 1.	Resizing	 2. Merging		  3. Layout			  4. Design	
	 5.	(This question was incorrect in the textbook, please correct it in your textbook)
		  Q. _____________is the white space all around the printed area of the paper.
		  A. Page margin
C.	 1.	F		  2. T			   3. T			   4. F				    5. F

ItLet's Do

A.	 1.	 It is the intersection of rows and columns. 
	 2.	Header is the text that appears at the top of each page of the document. 
		  Footer is the text like page number that appears at the bottom of each page of the document. 
	 3.	Page margin is the white space all around the printed area of the paper. 
B.	 1.	To add a row, follow these steps:
	 	 Step 1  Select the row where you want to add another row.
	 	 Step 2  Click on the layout tab.
	 	 Step 3  Click on Insert Above or Insert Below command. A row will be added.
	 2.	To insert a table, follow these steps:
	 	 Step 1  Open the MS Word and click on the Insert tab.
	 	 Step 2  Click on the Table command in the Tables group.
	 	 Step 3 � �Move the mouse over the squares to select columns and rows for the table. When 

you move the mouse over the squares, a sample table is visible in the document.
	 3.	The Mail Merge feature in MS Word is used to create personalised letters to be sent to many 

persons. 
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Crack CodeThe

Do yourself.

	More on MS PowerPoint 2010	More on MS PowerPoint 2010

One LearnTouch

A.	 1. c	 2. a		  3. b		  4. c
B.	 1. F	 2. F		  3. T		  4. T
C.	 1.	Slide	 2. Slide layout		 3. Reading		  4. Saved images	
	 5.	(This question was incorrect in the textbook, please correct it in your textbook)
	 	 Q. __________ shows the current slide, the outline and the Notes pane. 
	 	 A. Normal view 
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ItLet's Do

A.	 1.	A slide layout is the arrangement of text, images, clipart and charts etc. on a particular slide.
	 2.	Normal view is used to change the slide layout.
	 3.	List, process and cycle are the three types of SmartArt.
B.	 1.	To insert SmartArt, follow these steps:
	 	 Step 1  Insert tab.
	 	 Step 2  Illustration group.
	 	 Step 3  SmartArt command.
	 	 Step 4  Choose a graphic type form the left section of dialogue box.
	 	 Step 5  Choose design and click OK.
	 2.	WordArt allows you to create text effects that are not available through font formatting. You 

can insert WordArt in your slides also. To add WordArt to  a slide, follow these steps:
	 	 Step 1  Select the text to be converted to a WordArt style.
	 	 Step 2  �Click on WordArt command in the Text group on the Insert tab. A drop-down menu 

appears with different types of WordArt styles.
	 	 Step 3  Select the desired style. A textbox will appear in the document.
	 	 Step 4  Enter text in the textbox. 

Crack CodeThe

	 1.	(This question was incorrect in the textbook, please correct it in your textbook)
	 	 Q. It displays a large view of the current slide.
	 	 A. Slide area 
	 2. WordArt/Text box		  3. Notes pane	
	 4.	(This question was incorrect in the textbook, please correct it in your textbook)
	 	 Q. To use ready-made pictures on the slides. 
	 	 A. ClipArt  

Do yourself.

Periodic Assessment-2Periodic Assessment-2
(Based on chapters 3 to 5)(Based on chapters 3 to 5)

A.	 1.	T	 2. F		  3. T		  4. F		  5. T		  6. T
B.	 1.	Placeholders	 2. Slide Sorter View	3. Slides			   4. Saved images
	 5.	 (This question was incorrect in the textbook, please correct it in your textbook)
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		  Q. __________ shows the current slide, the outline and the Notes pane. 
		  A. Normal view 
C.	 1.	 Insert above	 2. Insert below		 3. Delete			   4. Merge cells

Test Sheet-1Test Sheet-1
(Based on chapters 1 to 5)(Based on chapters 1 to 5)

Section A
A.	 1. b		  2. b			   3. a			   4. a		  5. b			   6. b
B.	 1.	Pixels		  2. Platters	 3. Sub folder		  4. Format
C.	 1.	F		  2. F			   3. T
D.	 1.	(d)		  2. (c)			  3. (a)			  4. (b)

Section B
A.	 1.	Shape feature is used to insert various ready-made shapes in the word document. 
	 2.	� It is the main memory of the computer. CPU can directly access this memory. It is fixed on 

the Motherboard. 
	 3.	Flatbed, Handheld and sheetfed are the different types of scanner.
B.	 1.	� The different views available in PowerPoint are Normal View, Slide Sorter View, Slide Show 

View, Notes Page and Reading View.
	 2.	Different types of printers are: 
	 	 (i)	 Dot-matrix printer—It works like a typewriter. The printer head strikes the paper and  

ink ribbon to print a character. It is an impact printer. 
	 	 (ii)	 Inkjet printer—These are non impact printers. It prints line by line by spraying ink on a 

sheet of paper. These printers are much faster than dot matrix printer. These are expensive 
and consume more ink. 

	 	 (iii)	 Laser printer—These are also non impact printers. IT uses a laser beam to print on the 
paper. These are much faster than the inkjet printer and print quality of these printer is 
superior.

	Introduction to MS Excel 2010	Introduction to MS Excel 2010

One LearnTouch

A.	 1. c		  2. c			   3. b		  4. a
B.	 1.	Name box	 2. Title		  3. Quick Access		  4. Formula		  5. Worksheet
C.	 1. F		  2. T		  3. F			   4. F			   5. F

66..



99Touchpad PLUS (Version 1.1)-V (Answer Key)

ItLet's Do

A.	 1.	Cell range is a collection of two or more cells. 
	 2.	Ribbon is a bar that has tabs with groups of related commands displayed in it. 
	 3.	This is the currently selected cell that appeared highlights with a dark border.  
B.	 1.	Formula bar is used to edit and enter formulas. It is also used for entering and editing the 

cell contents. 
	 2.	A workbook is a collection of different worksheets. By default a worksheet contain 3 sheets 

whereas, a worksheet is a single page in excel.

Crack CodeThe

	 1.	D3	 2. D5	 3. E4		 4. C4	 5. B4		 6. G4

Do yourself.

	More on Internet	More on Internet

One LearnTouch

A.	 1. a		  2. c			   3. b		  4. a
B.	 1.	 information		 2. search engines 		  3. downloading		  4. uploading
C.	 1.	F		  2. T			   3. T			   4. F
D.	 1.	(c)		  2. (a)			  3. (d)		  4. (b)
E.	 1.	Google Chrome			   2. Internet Explorer			  3. Mozilla Firefox

ItLet's Do

A.	 1.	 Internet is a network in which millions of computers are connected one another to share 
information. 

	 2.	Facebook, Twitter and Instagram are three social networking websites.
	 3.	Getting data from the host computer to the client computer is called as downloading. 
B.	 1.	Uses of internet are: 
	 	 •  We can buy and sell goods online. 
	 	 •  We can search information on any topic.
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B.	 1. c.		  2. a.			   3. b.

C.	 Quick Access 
Toolbar

Title bar

Formula bar

Mouse pointer
Active cell

Status bar

Sheet tab

Name box

	Advanced Blocks in Scratch	Advanced Blocks in Scratch

One LearnTouch

A.	 1. b	 2. b	 3. c
	 4.	(one option was printed incorrect, plese correct in you textbook)
		  Q. Which block is used to run the script continously? 
		  a. Repeat	 b. Looks	 c. Forever
		  A. c. Forever  
B.	 1.	Operators	 2. Arithmetic	 3. Relational
	 4.	(This question was incorrect in the textbook, please correct it in your textbook)
		  Q. In Scratch, the variables can be created using ________blocks.
		  A. Data
C.	 1.	T	 2. F	 3. T	 4. T			   5. T

ItLet's Do

A.	 1.	Variable blocks are used to hold values.
	 2.	Pen up and Pen down are the two blocks of pen category.
B.	 1.	Arithematic, Logical and Relational are the different operators.
	 2.	(a) Stamp—It duplicates sprites image on to the stage. 
	 	 (b) Hide—Makes sprite disappear from the stage
	 	 (c) Pen up—Puts up sprite’s pen up so that it won’t draw as it moves on the screen. 
	 3.	� Forever block runs the script continuously until stopped. Whereas, if then else block checks 

the given condition. If the condition is true the then code inside the first space is activated 
else the code inside0 the second space is activated. 

99..

	 2.	 ISP is a company that provides internet access to people on payment of a monthly fees like 
Airtel, Vodafone etc. 

	 3.	Telephone lines and cables, Modem, Computer System, web browser and ISP are the things 
required to connect to Internet.

Crack CodeThe

	 1.	URL		  2. Surfing			  3. Telephone and Cable lines		 4. Internet

Do yourself.

	Data Processing	Data Processing

One LearnTouch

A.	 1. a		  2. b			   3. c

ItLet's Do

A.	 1.	� Data refers to the raw input. 
	 2.	� The process of converting a coded message into understandable language known as 

Decoding. 
B.	 Information can be represented in the form of tables, pictures, etc.

Crack CodeThe

	 1.	No parking					     2. Veg. & No. Veg.
	 3. Pedestrian crossing			   4. U-Turn prohibited 

Do yourself.

Periodic Assessment-3Periodic Assessment-3
(Based on chapters 6 to 8)(Based on chapters 6 to 8)

A.	 1.	19 15 18 20 9 14 7
	 2.	4 1 20 1
	 3.	16 18 15 3 5 19 19
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B.	 1. c.		  2. a.			   3. b.

C.	 Quick Access 
Toolbar

Title bar

Formula bar

Mouse pointer
Active cell

Status bar

Sheet tab

Name box

	Advanced Blocks in Scratch	Advanced Blocks in Scratch

One LearnTouch

A.	 1. b	 2. b	 3. c
	 4.	(one option was printed incorrect, plese correct in you textbook)
		  Q. Which block is used to run the script continously? 
		  a. Repeat	 b. Looks	 c. Forever
		  A. c. Forever  
B.	 1.	Operators	 2. Arithmetic	 3. Relational
	 4.	(This question was incorrect in the textbook, please correct it in your textbook)
		  Q. In Scratch, the variables can be created using ________blocks.
		  A. Data
C.	 1.	T	 2. F	 3. T	 4. T			   5. T

ItLet's Do

A.	 1.	Variable blocks are used to hold values.
	 2.	Pen up and Pen down are the two blocks of pen category.
B.	 1.	Arithematic, Logical and Relational are the different operators.
	 2.	(a) Stamp—It duplicates sprites image on to the stage. 
	 	 (b) Hide—Makes sprite disappear from the stage
	 	 (c) Pen up—Puts up sprite’s pen up so that it won’t draw as it moves on the screen. 
	 3.	� Forever block runs the script continuously until stopped. Whereas, if then else block checks 

the given condition. If the condition is true the then code inside the first space is activated 
else the code inside0 the second space is activated. 
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Crack CodeThe

	 1.	Pen block		  2. Arithmetic Operator		  3. Variables block		  4. Pen block

Do yourself.

	Concept of Smart Living	Concept of Smart Living

One LearnTouch

A.	 1. b		  2. b			   3. a
B.	 1.	Light		  2. AI			  3. Smartphone			  4. Smart smoke detectors

ItLet's Do

A.	 1.	Smart Homes are homes that use internet connected devices to empower remote monitoring 
and management of appliances and devices such as for lighting and heating.

		  The following are the benefits of smart homes:
		  i.	 Smart Homes are great in saving power.
		  ii.	 They are installed with smart security devices which helps in protecting the home and 

its belongings.
		  iii.	 They are connected to multiple devices and all of those devices can be accessed easily 

all at once with the help of a smartphone.
		  iv.	 They are installed with gadgets which can be accessed remotely and can control various 

functions.
	 2.	Smart Cameras, Smart Smoke Detectors, Smart Lighting, Smart TV
B.	 1.	This device sounds an alarm when smoke is detected. It can warn you if there is fire in your 

home.
	 2.	Smart TV allows its users play music, movies, or change channels using Internet. And all this 

can be controlled with your voice.

Crack CodeThe

	 1.	Video Doorbell		  2. Smart Speaker		  3. Smart Hub

Do yourself.
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Periodic Assessment-4Periodic Assessment-4
(Based on chapters 9 & 10)(Based on chapters 9 & 10)

A.	 1.	Smart Speaker	 2. Smart Smoke Detector	 3. Video Doorbell
B.	 �Shruti can use smart cameras.
C.	 1.	Hat blocks always come at the top of a script.
	 2.	A Script is made by many blocks.

Test Sheet-2Test Sheet-2
(Based on chapters 6 to 10)(Based on chapters 6 to 10)

Section A
A.	 1.	(a)		  2. (b)	
	 3.	(this question was incorrect in the textbook please correct in your textbook)
		  Q. ............................ allows its users play music, movies, or change channels using Internet. 
		  a. Smart TV 
		  b. Smart Speakers 
		  c. Smart Cameras
	 A. a. smart TV
	 4. (a)			   5. (a)
B.	 1.	Smart Smoke Detectors	 2. Data		  3. Hyperlink
	 4.	 (This question was incorrect in the textbook, please correct it in your textbook)
		  Q. In Scratch, the variables can be created using ________blocks.
		  A. Data
C.	 1.	T		  2. F			   3. F			   4. F			   5. T			   6. F
D.	 1.	(c)		  2. (a)			  3. (d)		  4. (b)

Section-B
A.	 1.	� When the data is processed, the outcome received is known as information. 
	 2.	� Web browser is a software program which helps the user in opening and displaying the 

different web pages. The different types of web browsers are Google Chrome, Internet 
Explorer, Mozilla Firefox, Opera etc.

	 3.	� Smart cameras are used to monitor the indoor and outdoor activities. It not only records the 
movements but also sends alerts for suspicious movements.

	 4.	Slide layout refers to the way of arranging objects on a slide.
	 5.	Uses of internet are: 
	 	 •  We can buy and sell goods online.
	 	 •  We can search information on any topic.
B.	 1.	Smart TV allows its users play music, movies, or change channels using Internet. And all this 

can be controlled with your voice.
	 2.	Stamp block duplicates the sprite’s image on the stage. 
	 3.	� Computer system, Telephone and cable lines, Web browser, ISP and Modem are required to 

connect to Internet. 


